
WindowControl95 version 1.61

WindowControl is a desktop window manager for Windows 95. WindowControl let's you 
control your windows either by hand, or automatically, using AutoPlace. WindowControl 
started as just a way in which to move windows on the screen, but as further releases 
went by, it has grown far more powerful than that. In addition to being able to move, 
resize, minimise, maximise, centre, close, hide/show, top and untop windows you can 
also use WindowControl's more advanced features to ease using Windows 95. 

More advanced features that give control over multiple windows are:-
Minimise All/Undo Minimise All - Faster and more powerful than the Windows95 built in 
command
Hide All/Undo Hide All - Hide away programs until you need them again
AutoFit - Make sure all windows fit on the screen and aren't hidden of the edges.
AutoPlace - Carry out any of the standard features automatically on as many windows 
as you like.



WindowControl History
Version 1.61 - 29th March 1998
*    Improved efficiency. Now uses between 2 and 3 times less CPU time. (Refreshing the 
window list is also much faster because of this).
*    Registered users can disable the splash screen for security reasons.
*    Improved the way the program runs from the tray.

Version 1.60 - 15th March 1998

*    Added the Sidebar to quickly carry out operations on picked desktop windows.
*    WindowControl now has a 'flat' toolbar if your version of COMCTL32.DLL is greater than 
4.70.
*    ...and of course fixed a couple of tiny bugs.

Version 1.51 - 28th February 1998

*    Added ability to automatically close a window or class using AutoPlace.
*    Minor bug fixes.

Version 1.50 - 16th February 1998

*    First fully 32-bit Windows 95 specific version.
*    Windows 95 Explorer like interface, toolbar, statusbar, minimise to tray and other standard 
Windows 95 benefits.
*    AutoFit - windows automatically moved and resized to fit into the desktop.
*    Shutdown section now includes 'log on as new user' and 'Exit to DOS'.
*    Hide the Taskbar, hide the desktop, start your screen saver with one click.
*    This help file to make things even easier. :-)
*    New Statusbar shows current window count, time and also can be used to quickly enable 
and disable AutoUpdate, AutoPlace and AutoFit
*    Many other enhancements, just use the program and you'll see all the benefits!

Version 1.45 - 23th December 1997

*    Now works with fuzzy window titles. This means you can have titles like '* - Netscape', or 
"Microsoft Word - *" and it will find all windows that match these wild-card    searches. 
*    Improved functionality when using AutoPlace means normallised windows can be set so that 
only specific attributes are modified. This allows for windows to always be a certain size, but not
be moved on the screen, or vice-versa. 

Version 1.4 - 12th November 1997

*    You can now undo the last command. You can undo hiding a window, renaming a window, or 
maximising or minimising a window. 
*    A new command, Hide All has been added. 
*    You can set certain windows to be unaffected by Hide All and Minimise All. 
*    You can view and restore windows that have been hidden using AutoHide. 
*    Restore now sets a window to its previous state, not just it's normal state. 
*    You can specify the interval for AutoHide. 



*    You can centre windows. 
*    Improved preferences dialog with more options. 
*    Minimise All is faster. 

Version 1.3 - 25th October 1997

*    Can shutdown windows, restart windows, or restart your PC. 
*    Improved interface (added a menu) to more quickly access WindowControl's features. 
*    Added shortcut keys. 
*    Save a program's icon to a bitmap. 
*    Copy a program's class, title, path or handle. 
*    When you change the name of a program, it keeps the focus. 
*    Restore AutoHide during program running, not just on exit. 

Version 1.2 - 12th October 1997

*    Wizard for adding new windows or classes 
*    Quick picker when shrunk 
*    You can start shrunken to save space 
*    Can now shrink to the right hand side of the screen 
*    AutoPlace list is now sorted 

Version 1.1 - 25th September 1997

*    Can choose which windows to restore when exiting. 
*    Now can AutoHide multiple windows with the same caption, and then restore them. 
*    Ability to shrink main window to save space. 

Version 1.0 - 17th September 1997

*    Initial release. 



WindowControl95 Features
Standard Features
These are features that can be carried out on windows from the main screen.

Move and Resize

This only works on visible windows. Select a window from the list, and then press the 
Properties button ( ) on the toolbar, or shift-click with the mouse.

This brings up a dialog box with the windows current size and position. Either by typing 
in new values, or using the slider bar, you can reposition and resize the window.

 Topping
This places any window on top of any other non-topmost windows. This means that it is 
always visible and never covered by any other windows.

 Centre
To quickly centre any window on the desktop choose this command.

.

 Minimise, Maximise, Close
The standard Windows commands to minimise, maximise and close a program. This 
just makes things much easier, because you don't have to go into the program itself to 
carry out these commands.

 Hiding and Showing Windows
Hiding a window will remove it from the screen. You wont be able to ALT-TAB to it, and it
won't be in the Taskbar either. This is useful for some programs that you need running 
all the time, but don't want in the way. Things like the Windows Connected To... dialog 
when your connected to the Internet. To show these windows again (or any other hidden
window) press F7 which will show you the list of hidden windows, and double click or 
choose restore to make the window visible again.



WindowControl95 Features
AutoPlace

With AutoPlace, you can automatically move, resize, close, hide or top any window or 
windows. You can do this both for specific window titles, or all windows of a certain 
class.You can also automatically minimise or maximise windows as well.

This is both a very handy and very powerful tool. It can be set up so that your programs 
always appear on the same position on your desktop and as the same size. It can be 
set so that certain programs are always on top (very handy when talking to someone on
IRC and browsing the internet at the same time). Windows can be automatically tilled so
when working on a large project you can see all the programs you want on the screen at
the same time. there is no limit to the uses you can put AutoPlace to once you set it up!

Goto the AutoPlace Preferences section for more details on how to use AutoPlace.



WindowControl95 Features
AutoFit
AutoFit checks the desktop at a user specified interval of time to see if any windows are 
placed off the screen. If it finds any windows that are not 100% visible, it will move them
onto the screen. If any window is too large to fit onto the screen then it will automatically
be shrunk so that it fits.

The only windows that are not affected by this are any that are in AutoPlace. This 
means if for some reason you want a window to be partially off-screen, you can set it in 
AutoPlace for this, and AutoFit will not try to fix it's position.

AutoFit can also detect the position and size of the Windows 95/NT start bar and 
compensate for it as well. By pressing the 'Get Taskbar Position' button from the AutoFit
preferences section, WindowControl puts the Taskbar size and position into the 
preferences for you. Then, whenever a AutoFit is carried out, it will not only make sure 
all of a window is on the screen, but will also make sure that it is not obscured by the 
Taskbar.



WindowControl95 Features
Minimise And Hide All

Minimise All

Frequently in Windows, you have lots of programs running and you want to get to an 
icon on your desktop. Selecting Minimise All will minimise all windows faster than the 
Windows 95/NT standard command, giving you access to your desktop.

Hide All

This works in the same fashion as Minimise All, but instead of minimise all your 
windows, it hides them from the screen entirely. This can be handy if you are working on
different projects and you want to have a lot of programs running, but don't want to 
access them all at the same time. You can quickly hide everything, then go into the 
Invisible window list and just restore the few programs you want.

This is however slightly cumbersome. To make this feature far more powerful you can 
specify in the preferences section certain windows, or window classes that will not be 
hidden by the hide all command. (You can also set up minimise all to not minimise 
certain windows as well).

Adding a window to the Minimise or Hide All lists is the same as it is for adding an entry 
to AutoPlace. Drag and drop from the main window list, or type in the name in the text 
box, and press enter. You can then edit as normal and switch from title to class.

Also check the Tools preferences section for more on how to do this.



Customising WindowControl
General Preferences
Here you change the way that AutoUpdate and AutoPlace function.

AutoUpdate

You can disable AutoUpdate. Doing this means that you will have to manually refresh the window list and 
that AutoFit and AutoPlace will not find new windows unless you refresh the list.

You also can set the interval at which AutoUpdate checks for new windows. This figure is in milliseconds, 
so the figure of 1000 is 1 second. The default for this is 1000.

AutoPlace

Disabling AutoPlace means that none of your AutoPlace entries will not be checked for. It is frequently 
better to disable either AutoHide or AutoTop instead.

Here you can also set the interval for AutoPlace to check for windows to place. Again the default value is 
1000. (There is little point setting this value lower than AutoUpdate).

Display Icons

This turns off showing the icons in the main window list in WindowControl. It doesn't work properly until 
you restart the program however. This makes WindowControl run slightly faster and use less resources.



Customising WindowControl
Position Preferences
Here you change some WindowControl properties.

Always on top

Setting this means that WindowControl will always be placed on top of any other windows. (If you top 
windows with WindowControl however, they will be placed on top of WindowControl. To make 
WindowControl ontop of them again, just go into the preferences and press OK or Apply).

Remember Size and Position

If you have remember size on, then WindowControl will always be the same size when it runs from the 
last time it was run. Also the window list columns will be the same size as well. 

Remembering position means it will always load the main window on the same place on the screen.

(We recommend you check both these values)

Start Position

This allows you to start WindowControl in one of 3 ways.

Normal - Shows the main window on load.

Shrunken - as a box in the corner of the screen. You can specify which corner.

Tray - WindowControl appears as an icon in the Tray bar.

Minimise to tray means that when you minimise WindowControl, instead of appearing on the Taskbar, it 
appears in the tray.



Customising WindowControl
Tools Preferences
Here you change the way that Minimise and Hide All function.

Adding entries

Select from the check boxes at the bottom of the screen whether you want to edit Minimise All or Hide All.

Like with AutoPlace, type an entry in the text box, or drag and drop a window from the main window list. 
You can make the entry a Title or a Class quickly from the drop-down. To remove an entry, select it and 
press Delete.

All the entries in these two lists will now not be minimised or hidden whenever you choose the Minimise or
Hide All commands respectively.

Note: You should add "Program Manager"(Title) or "Progman"(Class) to this list as it cannot be minimised 
or hidden, and will make the functioning if these commands better.



Customising WindowControl
AutoPlace Preferences
This displays a list of all the AutoPlace entries you have, and let's you add new entries 
and edit old entries.

Adding a Window to AutoPlace

You can either use the Window Control Wizard or manually add entries to the AutoPlace
list. The wizard is more intuitive, however some people might find the old way quicker to
add entries, so you can choose not to use the wizard if you want.

There are two ways of adding items manually..

Select a entry from the window list and drag and drop that entry onto the AutoPlace list 
in the Preferences dialog. This adds the window and it's current position to the list.

Alternatively, just type in the name of the window in the text box above the AutoPlace 
list, and press the Shift+Enter keys. This adds the window, but you will have to then 
specify the positions manually.

Working with AutoPlace

Once you've added your Windows and Classes, you'll want to manipulate them. If you 
just want a window to be placed in a part of the screen at a certain size, then all you 
have to do is change the top and left fields for the position, and the width and height 
fields for the size. If instead you want the window to be automatically Minimised, 
Maximised or Closed, choose them instead of Normal. If AutoPlace is switched on in the
General section and this window title exists, then the changes will be carried out as you 
work so that you can instantly tell if you are happy with your settings.

If you leave any of Left, Top, Width and Height as blank values, then only the non-blank 
values will be altered. This means you can make sure a window is always in a certain 
position, but not alter it's size. Or, alternatively, always a certain size, but will appear 
wherever Windows decides to open it. Or further, a window can be a certain width or 
height or whichever of these values you wish.

To Hide or Top a window, all you do is select the option from the lists as well. You 
cannot top a Class though, because that would be too dangerous! Also be careful if you 
have a window set to be maximised, as if you top it as well, you won't be able to get to 
any other windows until you close it.

Window Control prioritises Window Titles before Classes. For example if you have 
"Untitled - Notepad"(title) and "Notepad" (class) as your entries. Then, if "Untitled - 
Notepad" is set to Maximise the window, and "Notepad" is set to position the window to 
a set size and position, then when you open Untitled - Notepad, it will always maximise, 
and ignore the settings for Notepad as a Class.

If you set a entry to be closed when found by AutoPlace, then all other options will be 
disabled. (There is no point moving a window if it is going to be closed!).

Editing your Entries

If you want to edit your title, or make an entry a class, then it is simple to edit it. To 
change from Title to Class all you do is change the drop-down box in the bottom left 
corner of the screen to the value you want. Of course you still have to change to the 



class name as well. To alter this (or change any caption) select the entry to wish to alter 
and type in the new caption in the text box at the top of the screen and press the Enter 
key to save any changes.

Removing AutoPlace Entries

To remove an entry, select it from the list, then press the Delete key.



Customising WindowControl
AutoFit Preferences
Here you change the way that AutoFit functions.

The first option disables and enables Autofit. If you enable AutoFit, it automatically enables AutoUpdate as
well because it will only check for windows when AutoUpdate is enabled.

For people who have their Taskbar on always on top, then you can set up Autofit so that windows don't 
get hidden under the taskbar, which is frequently a nuisance, especially for people like myself who have 
the Taskbar at the top of the screen and can therefore often not get to a programs title bar.

Pressing the Get Taskbar Position button finds out where your taskbar is on the screen and it's size and 
enters those values in the requisite boxes. Now whenever AutoFit finds a window hidden under the 
Taskbar as well as off the desktop it will move it onto the desktop, and if necessary resize it to fit the 
desktop as well.



AutoPlace Wizard
The WindowControl wizard is an intuitive guide for adding new AutoPlace entries.

In a few quick steps you can add a new entry to the AutoPlace list.

Step 1: Choose a window to add

From the drop down choose a currently running program or type in the name of a new window.

Step 2: Class or Title

Select whether your new entry should be a class or a title. If you select a class and you chose an entry 
from the drop down, then the class name will automatically replace the title.

Step 3: Top, Size and Visibility

Quickly choose whether the entry should be Topped or not. Made to be hidden or left alone and finally 
whether it should be resized to be minimised, maximised or untouched.

Step 4: Size and shape

If your entry is to be minimised or maximised or hidden, then you can skip this section and press finish to 
add the new entry.

Otherwise, you can move enter here values for the new position and size of your entry.

Finish

You will then be shown a summary of what your new entry is to be. If you are happy with it, then press 
Finish, otherwise go back and alter any of the values.



Support for WindowControl95
Although WindowControl is a shareware program, I will try to provide support for non-registered users if I 
feel they do not abuse my trust. i.e. If it seems that they are genuinely unsure of a feature of 
WindowControl and that is preventing them from trying out the program within the 30 day trial period.

Registered users however will get my upmost attention and I will endeavor to help them out with any 
problems they may encounter as soon as I can.

All support issues should be emailed to the usual address, WindowControl@USA.NET with the word 
SUPPORT as the subject line.

NOTE: Although fully 32-bit, WindowControl95 does not run on WindowsNT 4. This is because it uses 
features specific to Windows 95, that Microsoft left out of NT 4. There should be a version of 
WindowControl for NT 4 available soon. You can however run the Windows 3.1 version of WindowControl
without any difficulties on Windows NT 3.51 and Windows NT 4.0.



Registering Window Control
WindowControl is not unique, but I think it is the best program out there for manipulating
windows. Therefore, I don't think I'm being unfair asking for £10(UK) or $20(US) for this 
program. WindowControl has no disabled features, so I'm relying on your good natures 
to register this program.

Benefits of Registering

If you register, I'll notify you of any updates to WindowControl.

Put your suggestions at the top of the ToDo list.

You will get any future upgrades to WindowControl 1 for free.

The nag screen and 5 second delay when you load the program will be removed.

You might even feel better at helping out a poor programmer, but I guess that might be 
stretching reality too far.

How to Register

To register, send a cheque, postal order or bankers draft (or cash if you want to take the
risk) for £10 (UK)    or $20 (US) for each copy of WindowControl made payable to Harry 
Cohen at the following address.

Harry Cohen

73 Milverton Road

Giffnock

Glasgow G46 7LQ

Scotland

UK

Include your email address so that I can send you your registered version of 
WindowControl, and can add you to the list of registered users so that I can inform you 
of upgrades to Window Control.

If you want to contact me about alternative methods of payment, or site licenses then 
email me to WindowControl@USA.NET



Quick Tips
WindowControl was designed for two main purposes although it can of course be used for whatever you 
want. I wrote WindowControl to help me when I was using the Internet, and when I am programming.

It was designed primarily as a tool to control windows when using the Internet, and 
when programming. Standard uses for WindowControl are therefore, 

* Hiding the "Connected To.." dialog box when logged onto the Internet.

* Hiding all DCC file transfers on IRC.

* Having file downloads placed on top, so that you can talk on IRC and also monitor 
your downloading at the same time.

* Automatically maximising Notepad so that you have a full screen to work with.

* Tilling two frequently used files side by side each time they run.

* Changing your browsers window to a standard window size (e.g. 640*480, 800*600) 
for testing out your HTML.

Obviously there are many other uses for WindowControl and these are just some of the 
things it can be used for.



Window Classes are properties of every program. Most windows programs have a class name. For 
instance every time you run MicroSoft Word, no matter what file you open in it, it's class name is 
OpusApp. MicroSoft Notepad's class is simply Notepad.



AutoHide is the part of AutoPlace that automatically hides windows. Disabling this means that no windows
will be hidden even if AutoPlace is active.



AutoTop is the part of AutoPlace that places windows always-on-top. Doing this means that windows are 
still positioned and resized with AutoPlace, but will not be topped. This disables topping for ALL entries.



Shrink mode shows WindowControl as a small icon in the corner of the screen. Right clicking on this icon 
shows the list of currently running windows for quick access. This is handy when using WindowControl as
a task manager. You should have WindowControl always on top when using it in this way.



The visible screen. For instance, if you have your monitor set to 640*480 pixels, then that is the size of 
your desktop. Anything outside that is considered outwith the desktop, and will be placed inside this 
region.



This area of the main screen shows all the currently running windows. Depending on your current view 
this will be either all Visible, Hidden or automatically hidden windows.
It shows the icon associated with each program, it's Window's handle, it's class (useful for adding 
AutoPlace entries) and it's path.



The WindowControl toolbar provides quick access to the main features, such as, topping, minimise, 
maximise, hiding and showing windows.



The status bar shows the number of currently running windows.
The dots on the right hand side of the status bar show the current status of the automatic functions.
The first circle will be blue if AutoUpdate is enabled.
The second circle will be red if AutoPlace is enabled.
The third circle will be green if Autofit is enabled.
You can double click on these circles to quickly enable and disable these functions. The circles appear 
emtpy when these functions are disabled.



The Sidebar lets you quickly pick any window on the desktop and carry out a standard operation on it. 
Operations that are available are minimise, maximise, close, centre, top, untop and hide.



The columns above the Window List can be selected to sort the current entries.



WindowControl Menus
The File Menu
File menu commands that have a toolbar button have their buttons displayed beside them.

 New...
This opens the WindowControl Wizard which helps in creating new AutoPlace entries.

Save Icon...

When enabled (selected an item from the list of open windows) this allows you to save the associated
icon of that program as a Windows BMP file.

Run...

This brings up a dialog so that you can quickly run any program, folder or, shortcut.

 Properties
This displays the properties box for the selected window. This allows you to quickly move a 

window if it is a visible window.

 Refresh
This updates the window list to show the currently running processes. Useful is you have 

AutoUpdate turned off, or at a high setting and want to update the list quickly.

 Exit
This shuts down WindowControl. Why would you want to do that? :-)



WindowControl Menus
The Edit Menu

 Undo/Redo
This will undo or redo the last command. For example if you renamed a window, you could undo 

that change, or if you maximised a normal window, you could restore it to it's normal state.
Copy Commands

Copies the Title, Class, Path or Handle    of a program window to the clipboard.

It is frequently useful to copy a program's title or handle to the clipboard when adding new AutoPlace 
entries.



WindowControl Menus
The View Menu

Toolbar and Statusbar

Check/Uncheck these to view/hide the toolbar or Statusbar.

 Change Views
This changes the default view within WindowControl. The default value is Details where you can 

see all the information about programs.
Arrange Icons

Sort Icons to either Title, Path, Handle or Class. Most useful when not in Details view.
Line Up Icons

Aligns the icons of the running processes.
Shrink

Shrinks the window to a small box in a user specified corner of the screen. This is left-over from 
the Windows 3.1x version where it was not possible to minimise to the tray, and you wanted to still have 
quick access to WindowControl. It is still useful as it brings up a list of currently running programs without 
showing the main window.
Visible/Invisible

Toggles between showing invisible and visible program windows.

AutoHide List

This displays all windows that have been automatically hidden using AutoHide.

Options...

Change the settings for WindowControl. Look at the Customising WindowControl section for more 
details of this.



WindowControl Menus
The Tools Menu
File menu commands that have a toolbar button have their buttons displayed beside them.

Minimise All/Hide All

Quickly minimises or hides all program windows, or restores them again.

Shutdown Commands

Standard Windows 95 shutdown commands only one click away.

Miscellaneous Tools

 Start...
Shows the Windows 95 Start Bar.

Screen saver
Instantly runs your Windows 95 screen saver. (Does nothing if you don't have a screen saver 

configured).
Hide Taskbar

Hide the Windows 95 Taskbar.
Hide Desktop

Hides all Desktop icons.



WindowControl Menus
The Program Menu
File menu commands that have a toolbar button have their buttons displayed beside them.

 On Top/At Bottom
Topping a window places it at the top of the Windows Desktop and above all other windows. This 

means it will always be on top of any other non-topped windows, and will therefore always be visible. To 
remove this property from a window, you untop it with the 'At Bottom' command, which places the window 
at the bottom of the Desktop chain (i.e. the end of the ALT-TAB list) and removes it's topmost attribute.
Set Focus

Gives the currently selected window the focus, and brings it to the front of the Desktop.

 Restore/Hide
Either hides a visible window (removes it from the Desktop, ALT-TAB chain and Taskbar) or brings

back a hidden window.

 Centre
Centres the selected window on the screen.

 Minimise/Maximise
Simply and quickly minimises or maximises the selected window.

 Close
Shuts down the selected window or process.(NOTE: when doing this to a hidden window, beware

this could cause consequences beyond just closing this one window).



WindowControl Menus
The Help Menu
File menu commands that have a toolbar button have their buttons displayed beside them.

Contents

Displays this help file.

About

Shows the current version of WindowControl and displays system information.

Register

Enter your registration details here to register WindowControl.




